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To print a document on a transparency using the Transparency tray, see “Printing on Transparency
(using Transparency Tray)” on page 49.

*1Recommended paper is as follows: 
Letter/Legal: Hammermill LASERPRINT 90 g/m2 (24 lbs.)
A4: 4CC 80 g/m2

About Media

Media Description

Laser paper*1

Transparency

B&W: 60 to 105 g/m2 (16 to 28 lbs.)
Color: 75 to 105 g/m2 (20 to 28 lbs.)

3M CG3710

About Media

For Media Tray

For Multi-purpose Tray

Media Description

Laser paper

Transparency*2

Single-sided printing: 75 to 165 g/m2 (20 to 44 lbs.)
Manual duplex printing*1: 75 to 165 g/m2 (20 to 44 lbs.)

3M CG3710

Labels Avery 5163-5165, L7163, L7165-L7169

Envelope #10 [Black text only]

To print a document on a transparency, label or envelope using the multi-purpose tray, see
“Printing on Transparency, Label or Envelope (using Multi-purpose Tray)” on page 52.

*1When you perform the duplex printing, you should not expect the same print quality and reliability
that you get with single-sided printing. See the Specifications.

*2The print quality may not be stable. Use the media tray for best reliability.

For the notes and detailed media specification, refer to Specifications.

Cardstock Up to 165 g/m2
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The printer is shipped with a media tray (Letter paper or A4 paper) installed. Besides them, the
following media can be used with five different trays.

Each tray is designed and labeled for only paper or transparency. If you load the incorrect media type
in a tray, it may cause a jam.

NOTE
BIf you have the 2nd Cassette Feeder installed:

 If you wish to use the automatic cassette-switching feature (a large print job, for

example), make sure that all trays in the printer are the same media type and size.

 The transparency tray should only be inserted in the upper or middle tray slots.

Loading Media

Using the Media Tray

Legal Paper

Tray Size

A4 Paper

A4 Transparency

Letter Paper

Letter Transparency

210 mm x 297 mm (8.3″ x 11.7″)

210 mm x 297 mm (8.3″ x 11.7″)

216 mm x 279 mm (8.5″ x 11″)

216 mm x 279 mm (8.5″ x 11″)

216 mm x 356 mm (8.5″ x 14″)

Loading Media

Upper tray slot
Middle tray slot



Settings and Printing Maintenance Specifications 5

1 Pull the media tray out of the printer.
To use an appropriate media tray, always check the label indication on the tray.

2 Push down on the metal plate until it clicks, locking it in place.

3 Fan the media (paper/transparencies), then tap it on a level surface to avoid
media jams or skewed printing. 

NOTES
BBe careful not to leave fingerprints on the media, which can result in a smudged print.
BReusing media that has been fed through the printer once (for example, after jams) can

reduce the life of the consumables and paper path components.

Loading Media

Label
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4 Place the media with the print side down under the hooks in the tray.
The height of media should not exceed the limit mark on the tray, or it may cause a jam.

NOTES

BMost media has instructions recommending the side to be printed first.
BDo not mix different types or thicknesses of media in the media tray at one time; this may

cause a jam.

BWhen using transparency (3M CG3710), be sure to use the transparency tray and load it

with the leading tape side facing up (3M CG3710) and the taped end under the hooks.

5 Slide the media tray completely into the slot.

NOTE

BWhen using transparency with leading tape, remove the tape after printing.

Loading Media

Paper Transparency

Leading tape side up
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The multi-purpose tray (MPT) serves as an additional tray for loading any type of media that ranges in
size from 91 mm x 254 mm to 216 mm x 356 mm (3.6″ x 10″ to 8.5″ x 14″).

■ Setting media thickness switch:
Because of the most reliable paper-picking for various media weights, media thickness can be
manually selected.

1 Open the left side door. 

2 Move the media thickness switch to the desired setting.

3 Close the left side door.

Loading Media

Using the Multi-purpose Tray

Thin
Middle

Thick

Laser paper 91 to 123 g/m2 (25 to 32 lbs.)
Transparency, Coated paper, Label

Laser paper 75 to 90 g/m2 (20 to 24 lbs.)

Laser paper 124 to 165 g/m2 (33 to 44 lbs.)
Envelope #10
Card stock up to 165 g/m2

Thin (Default)

Switch setting

Middle

Thick

Media
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■ Loading Media:

1 Set the media thickness switch.

2 # Open the multi-purpose tray.
$ Extend the media support.

3 Separate the media guides to the approximate width of the media.

4 Fan the media, and then tap it on a level surface to avoid media jams or
skewed printing.

NOTES
BReusing media that has been fed through the printer once (for example, after jams) can

reduce the life of the consumables and paper path components.

BWhen printing legal size using the multi-purpose tray, backside marking may occur. If this

occurs, use the legal paper tray.

Loading Media

$

#



5 Insert the media with the printing side up into the multi-purpose tray.

The height of media should not exceed the limit mark on the left guide, or it may cause a
media jam.
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Loading Media

Taped side facing down
(3M  CG3710)

Paper Transparency

Envelope

Short-end

NOTES

BPlace only one envelope in the multi-purpose tray at a time. 

BWhen a wrinkle occurs, try printing with the flap inserted inside the
envelope as shown in figure.

Confirm the setting of the
media thickness switch.
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6 Adjust the media guides to the media size.

7 Use the printer driver to select the multi-purpose tray and media type.

(Refer to “Paper Tab” on page 34).

NOTE
BWhen using transparency with leading tape, remove the tape after printing.

The image (print area) is printed a bit smaller than the media size. You may need to adjust the page
margins in the application software to match the print area.
For detailed information, refer to Specifications.

Loading Media

Margins and Print Area
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Using the Printer Panel (Menu Mode)

The Menu mode includes a Main menu, Item menu, Selection 1 menu and Selection 2 menu which
can be changed from the printer panel.

Button Operation:
When Ready is displayed in the upper line of the LCD, pressing the MENU/EXIT button will allow you
to enter the Menu mode.

Once in the Menu mode, you can set the printer using the following buttons:

MENU
/EXIT

CONTINUECANCEL

ENTER

READY

ERROR

Button Operation

Display the next menu or item

G/CANCEL

Increase the numerical value of the selection by 1 or display
the next selection

F/CONTINUE

Display the previous menu or item

Decrease the numerical value of the selection by 1 or display
the previous selection

Enter a sub-menu

Activate a selection
H/ENTER

Using the Printer Panel (Menu Mode)

Printer Panel



Before you attempt to change any settings, check the factory default settings in the following table.
For details on changing the settings, refer to Outline for Operation (see page 18).

Once you have changed the printer panel settings, they are automatically saved as user default
settings even if the power is turned off.
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Indicator Status

The printer is ready for operation.

ERROR

The printer is warming up, printing or in the Menu mode.
READY

An internal error (Call for Service Error) has occurred.

User correctable error, such as media jam, open door, or
a missing replaceable component (e.g. toner cartridge)
has occurred.

LED

On

Blinking

On

Blinking

LED indication

Menu Table

Main Menu Item Menu

Test Page

Selection 2 MenuSelection 1 Menu

Menu Map

Calibration Offset

CYAN

MAGENTA

YELLOW

BLACK

Calibration Test Print

Reset Calibration

0* (-5 to 5)

0* (-10 to 10)

0* (-10 to 10)

0* (-10 to 10)

0* (-10 to 10)

No*

Yes

Configuration Page

Test Print

Bias Adjustment

* denotes the default setting. It is also shown on the LCD panel.

(continued)

Using the Printer Panel (Menu Mode)



Settings and Printing Maintenance Specifications 13

Main Menu Item Menu

Maintenance

Selection 2 MenuSelection 1 Menu

Page Count

Monochrome Page

* denotes the default setting. It is also shown on the LCD panel.

Sheet: ######Color Page

Toner Cartridge CYAN: ###% remaining

Imaging Unit

MAGENTA: ###% remaining

YELLOW: ###% remaining

BLACK: ###% remaining

###% remaining

###% remaining

Transfer Unit ###% remaining

###% remaining

###% remaining

Image Area

Fuser Unit

Oil Roll

Cleaning Pad ###% remaining

New Transfer Unit?Counter Reset

New Cleaning Pad?

Last

Charge Unit

Yes

No*

CYAN: ###%

MAGENTA: ###% 

YELLOW: ###%

BLACK: ###% 

CYAN: ###%

MAGENTA: ###% 

YELLOW: ###%

BLACK: ###% 

Average

Yes

No*

(continued)

Using the Printer Panel (Menu Mode)

Sheet: ######
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Main Menu Item Menu Selection 2 MenuSelection 1 Menu

* denotes the default setting. It is also shown on the LCD panel.
*1 Network Protocol Setup will not appear if the network card option is not installed in the printer.
*2 If the DHCP is enabled, these menus will not appear.

Power Saver On*

Off

DHCP Enable*

Disable

127.0.0.1*

255.255.255.0*

Network
Protocol Setup*1

Ethernet IP Address*2

Ethernet Subnet Mask*2

Gateway Address*2 255.255.255.0*

Language English

Français

Deutsch

Español

Italiano

Japanese

Using the Printer Panel (Menu Mode)

Adjustment to
Media

0* (-5 to 5)

0* (-5 to 5)

0* (-5 to 5)

0* (-5 to 5)

0* (-5 to 5)

0* (-5 to 5)

Plain Paper

Transparency

Label

Coated Paper

Envelope

Card
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Outline for Menus

Test Page
Prints the Menu Map, Configuration Page and Test Print.

■ Menu Map
Prints selectable menus.

■ Configuration Page
Prints general information on printer settings and configuration.

■ Test Print
Prints each color (CYAN, MAGENTA, YELLOW and BLACK) halftone to check for print quality.

Bias Adjustment
Adjusts the toner density for each color independently or all the colors.

■ Calibration Offset
Adjusts the density for all colors (CYAN, MAGENTA, YELLOW and BLACK). Setting a higher
number provides darker colors and setting a lower number provides lighter colors.

■ CYAN / MAGENTA / YELLOW / BLACK
Adjusts the density for each color independently. Setting a higher number provides darker color
and setting a lower number provides lighter color.

■ Calibration Test Print
Prints a Color Calibration Page with the current density settings.

■ Reset Calibration
Setting Yes resets the current settings back to the default settings.

NOTE
BThe color density setting affects the average life of toner.

Using the Printer Panel (Menu Mode)
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Maintenance
This menu shows what percentage of each consumable’s life remains to be used. Please note that
the values shown on the LCD panel are just the approximate values and are not always correct. So a
consumable indicating warning message might appear regardless of the displayed values.

For the life of supplies, see Maintenance. When a supply is replaced with a new one, the printer will
automatically reset the page counter for that supply (except transfer unit and cleaning pad) to 0.
When the transfer unit or cleaning pad is replaced, the counter must be reset by using the Counter
Reset menu (see below).

■ Page Count
It shows the total number of color and monochrome pages your printer has printed since your
purchase of the printer.

■ Toner Cartridge
It shows the remaining percentage of CYAN, MAGENTA, YELLOW and BLACK toner cartridges.

NOTE
BIf you replace a toner cartridge before LOW <Color> Toner is displayed, the remaining

percentage value of that toner cartridge will be incorrect.

■ Imaging Unit/Charge Unit/Transfer Unit/Fuser Unit/Oil Roll/Cleaning Pad
###% remaining shows the remaining percentage of the life of the item.

■ Counter Reset
BNew Transfer Unit?

You must select Yes when you have just replaced the transfer unit. The life of the unit will be
reset to 100% remaining.

BNew Cleaning Pad?
You must select Yes when you have just replaced the cleaning pad. The life of the pad will be
reset to 100% remaining.

Image Area
■ Last

It shows the percentage of the whole printable area covered by each toner (CYAN, MAGENTA,
YELLOW and BLACK) in the most recently printed page. This menu cannot show the value
correctly just after the printer is turned on. 

■ Average
It shows the average percentage of the printable area of all pages printed covered by each toner
(CYAN, MAGENTA, YELLOW and BLACK).

Using the Printer Panel (Menu Mode)
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Power Saver
To conserve energy and operating cost, this printer is provided with a programmable power save
feature. The printer is factory set with the power save feature turned on to comply with ENERGY STAR®
requirement. If power saver is enabled, the printer enters the Power Saver mode when the printer is
idle for 30 minutes.

If the power save feature is turned off, the temperature of the fuser unit in the printer is decreased to
save the power consumption when the printer is idle for 1 hour.

Network Protocol Setup
Selects DHCP or sets the addresses used by the TCP/IP protocol.

■ DHCP
DHCP automatically requests an IP address for the printer from a DHCP server.

■ Ethernet IP Address/Ethernet Subnet Mask/Gateway Address
If the DHCP is enabled, these menus will not appear. During setting, use the G/CANCEL,
F/CONTINUE and H/ENTER buttons.

G/CANCEL button: decreases the numerical value
F/CONTINUE button: increases the numerical value
H/ENTER button: moves the cursor to right

Adjustment to Media
If the print quality deteriorates when you print on other than recommended media (see Specifications),

the print quality may be improved by changing the setting of Adjustment to Media. The settings you

have changed will remain effective even if the power is turned off. Reset the settings again if any

changes in media or deterioration in print quality occurs. To reset the settings, refer to Setting the

"Adjustment to Media” for instructions.

■ Plain Paper / Transparency / Label / Coated Paper / Envelope / Card
It enables you to change the setting of the selected media in the menu.

You can select a value from 11 different levels (-5 to 5).

Language
Specifies the language of the LCD text and the language used in the Configuration Page.

Using the Printer Panel (Menu Mode)
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Using the Printer Panel (Menu Mode)

Outline for Operation

1 Press the MENU/EXIT button to enter the Menu mode.

2 Press the F/CONTINUE or G/CANCEL button until the desired menu is
displayed.

3 Press the H/ENTER button to enter the item menu.

4 Press the FF/CONTINUE or GG/CANCEL button until the desired item is
displayed.

5 Press the H/ENTER button.

6 Perform one or more of the following procedures (A, B, C) to configure your
printer.

When the menu does not have any lower-level menu (Test Page/Power Saver/

Language):

The printer starts printing a page or your selected menu is activated, then the printer exits the

Menu mode and Ready is displayed.

When the menu has lower-level menu:

Select your desired lower-level menu using the FF/CONTINUE or GG/CANCEL button, and

H/ENTER button.

BIf you have entered the selection 2 menu, then perform the above procedure once again.

When the numerical value needs to be entered (Bias Adjustment / Adjustment to Media):

Select your desired value using FF/CONTINUE (increase) or GG/CANCEL (decrease)

button,then press H/ENTER button to activate your selection.

B

A

C



NOTE
BFor details on the Network Protocol Setup, refer to the documentation of the optional

Network Card.

7 To exit the Menu mode, press the MENU/EXIT button.

NOTES
BTo exit the Menu mode at any stage, press the MENU/EXIT button.

BTo change the setting of an item of a different menu, first you exit the Menu mode, then

repeat steps 1 to 6 above.

Settings and Printing Maintenance Specifications 19
Using the Printer Panel (Menu Mode)
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Adjusting the Color Density (Bias Adjustment)

The printer panel provides an interface to adjust the density of the toner applied to the media. This
feature compensates for the changes in density that can occur as environmental conditions change,
toner cartridges or the color imaging unit age.

Perform the following steps to adjust the color density:

1. Print a color calibration page to confirm the current density (Bias Adjustment) and compare the

color calibration page with the provided color calibration card (see below).

2. If you wish to adjust the density for all colors simultaneously, proceed to “Adjusting the Density for

All Colors Simultaneously” (see page 23).

 OR 

If you wish to adjust the density for each color independently, proceed to “Adjusting the Density for

Each Color Independently” (see pages 24, 25).

1 Press the MENU/EXIT button on the printer panel.

2 Press the F/CONTINUE button.

3 Press the H/ENTER button.

4 Press the F/CONTINUE button 5 times and the following is displayed.

5 Press the H/ENTER button.

A Color Calibration Page will be printed.

Menu Mode
Test Page

Menu Mode
Bias Adjustment

Bias Adjustment
Calibration Offset

Bias Adjustment
Calibration Test Print

Printing a Color Calibration Page

Adjusting the Color Density
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The current density setting for each color is indicated by the line enclosure on the Color Calibration
Page as shown in the following example.
The factory default setting for each color density is 0.

Color Calibration Page (Example):

Current color
density settings

Adjusting the Color Density
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6 Compare the current color density settings on the Color Calibration Page with
the color density samples on the Color Calibration Card to see if they match. 

Place the Color Calibration Page on at least 2 sheets of clean white paper in a well-lighted
area.

BIf they match, then you do not need to adjust the color density and you may proceed with
any operation you wish to perform.

BIf they do not match, go to the next step.

7 Determine which block on the Color Calibration Page most closely matches
the density of the cyan sample on the Color Calibration Card. 
BRepeat this step for each color.

8 Proceed to “Adjusting the Density for All Colors Simultaneously” or “Adjusting
the Density for Each Color Independently”.

Color Calibration
Card

Adjusting the Color Density

Color Calibration Page

Clean white paper



1 Repeat steps 1 through 3 on page 20.

2 Press the H/ENTER button.

3 Press the FF/CONTINUE or GG/CANCEL button to darken/lighten all the
colors.
To make the color density setting of the Color Calibration Page darker or lighter by 1 level,

increase or decrease a value of the Calibration Offset by 2 by pressing the FF/CONTINUE or

GG/CANCEL button.

For example, when Calibration Offset is 0:
B If you wish to make the density setting darker by 1 level:

— Select 2 by pressing the FF/CONTINUE button 2 times.

B If you wish to make the density setting lighter by 1 level:
— Select -2 by pressing the GG/CANCEL button 2 times.

4 Press the H/ENTER button.

5 Press the FF/CONTINUE button 4 times and the following is displayed.

6 Press the H/ENTER button to reprint the Color Calibration Page.

B The line enclosure reflects the changes made to the settings.

B If you are not satisfied with the current color density settings, repeat the steps above.
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Adjusting the Density for All Colors Simultaneously

Bias Adjustment 
Calibration Offset

Calibration Offset
0* (-5 to 5)

Bias Adjustment 
CYAN

Bias Adjustment 
Calibration Test Print

Adjusting the Color Density



1 Repeat steps 1 through 3 on page 20.

2 Press the FF/CONTINUE button.

3 Press the H/ENTER button.

4 Press the FF/CONTINUE or GG/CANCEL button to darken/lighten the cyan
color.
To make the color density setting of the Color Calibration Page darker or lighter by 1 level,

increase or decrease a value of the CYAN density by 2 by pressing the FF/CONTINUE or

GG/CANCEL button.

For example, when the CYAN density is 0:
B If you wish to make the density setting darker by 1 level:
— Select 2 by pressing the FF/CONTINUE button 2 times.

B If you wish to make the density setting lighter by 1 level:
— Select -2 by pressing the GG/CANCEL button 2 times.

5 Press the H/ENTER button.
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Bias Adjustment
CYAN

CYAN
0* (-10 to 10)

Adjusting the Color Density

Bias Adjustment 
MAGENTA

Adjusting the Density for Each Color Independently



6 Repeat steps 3 through 5 for each color (MAGENTA, YELLOW, BLACK).

B To skip a color, press the FF/CONTINUE button.
B To return to a previous color, press the GG/CANCEL button.
B Before going to step 7, make sure the following is displayed.

7 Press the HH/ENTER button to reprint the Color Calibration Page.

B The line enclosure reflects the changes made to the settings.

B If you are not satisfied with the current color density settings, repeat the steps above.

NOTES
B Changes made using Bias Adjustment are retained until the printer is recalibrated.

B The color density setting affects the average life of toner.

B Save the Color Calibration Card for future calibrations.
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Bias Adjustment 
Calibration Test Print

Adjusting the Color Density
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Setting the “Adjustment to Media”

Setting the “Adjustment to Media”
If the print quality deteriorates when you print on other than recommended ones, change the

Adjustment to Media settings (see page 27). You can examine the print quality by printing out the test

pattern.

To print the test pattern,

1 Click  Start  , move the pointer to Programs, Panasonic and Panasonic 

KX-P8415, then click Print media test pattern.

The Print media test pattern window is displayed.

2 Select the KX-P8415 printer which prints the test pattern.

3 Click on Letter or A4 for Media size which the test pattern is printed.

4 Click on the Media Type check button corresponding to the media loaded in
the media tray or multi-purpose tray.
B When the MPT Envelope is selected, it is not needed to set the Media size.

5 Click  Print .

The test pattern is printed.

Ex. 1

Ex. 2
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Setting the “Adjustment to Media”

To set the Adjustment to Media,

1 Press the MENU/EXIT button on the printer panel.

2 Press theF/CONTINUE button until Adjustment to Media menu appears.

3 Press theH/ENTER button.

4 Press the FF/CONTINUE or GG/CANCEL button to select your desired media:
Plain Paper, Transparency, Label, Coated Paper, Envelope or Card.

5 Press theH/ENTER button.

6 # When solid color print for blue, red and green are not printed out evenly in
the Adjustment to Media test pattern (see Ex. 2 on page 26):
Select +1 value by pressing the FF/CONTINUE button and press
H/ENTER button.

$ Print out the test pattern corresponding to the media size and examine the
print quality. 
If the print quality does not improve, repeat steps 1 to 6 above to select a suitable value

by increasing + values.

 OR 

# When black, magenta and cyan half tone have weak color areas 
(see Ex. 1 on page 26):
Select   1 by pressing the GG/CANCEL button and press H/ENTER button.

$ Print out the test pattern corresponding to the media size and examine the
print quality.
If the print quality does not improve, repeat steps 1 to 6 above to select a suitable value

by increasing    values.

Menu Mode
Test Page

Menu Mode
Adjustment to Media

Adjustment to Media
Plain Paper
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Displaying the Panasonic KX-P8415 Properties Window

It is possible to set the printer by using the Panasonic KX-P8415 Properties window.
The Panasonic  KX-P8415 Properties window can be displayed from Windows®*1 (see below) or from
an application (see page 30).

When setting the printer by using Panasonic KX-P8415 Properties window under Windows 
(Start - Settings - Printers), the setting is retained even if Windows is shutdown and restarted.
However, when setting the printer by using the Panasonic KX-P8415 Properties window from an
application, the setting is returned to the default setting if the application is closed.

Choosing Printer Properties Under Windows:

1 Click Start  , select Settings, then click Printers.
The Printers window is displayed.

2 Click the Panasonic KX-P8415 icon.

*1 Microsoft® Windows® operating system (hereafter Windows)

A

Setting the Printer Driver
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4 Click a tab to view the features.

Details Tab (see page 31) [For Windows 95, Windows 98]
Color Management Tab (see page 32) [For Windows 98]
Sharing Tab (see page 33) [For Windows 95, Windows 98]
Paper Tab (see page 34)
Quality Tab (see page 37)
Setup Tab (see page 40)
Option Tab (see page 42)

*1 Microsoft® Windows® 95 operating system (hereafter Windows 95)
*2 Microsoft® Windows® 98 operating system (hereafter Windows 98)
*3 Microsoft® Windows NT® Workstation operating system, and Microsoft® Windows NT® Server

network operating system Version 4.0 (hereafter Windows NT 4.0)
*4 Microsoft® Windows® 2000 operating system (hereafter Windows 2000)

Setting the Printer Driver

3 Click the File menu, then click Properties (Windows 95*1/Windows 98*2),
Document Default...(Windows NT® 4.0*3) or Printing Preferences...
(Windows 2000*4).
The Panasonic KX-P8415 Properties window is displayed.

BTabs are different in Windows NT 4.0 / Windows 2000.
For Windows NT 4.0 / Windows 2000, it enables you to set another items by selecting
Properties of the File menu (see page 43).
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From an application

For example, to print a document created in Microsoft WordPad in Windows 95, perform the following
steps.

1 Click Start  , select Programs, select Accessories, then click WordPad.
The WordPad window is displayed.

2 Click the File menu, then click Print... .
The Print window is displayed.

3 Select Panasonic KX-P8415 in the Name : box.

4 Click Properties .
The Panasonic KX-P8415 Properties window is displayed.

5 Click a tab to view the features.

Paper Tab (see page 34)
Quality Tab (see page 37)
Setup Tab (see page 40)
Option Tab (see page 42)

NOTE
BThe print options in the File menu depend on the Windows application. Refer to the

application manual.

Setting the Printer Driver

B



NOTE
BThis option is available only in Windows 95 and Windows 98.

# Print to the following port
Select the port where the parallel interface cable is connected.

Settings and Printing Maintenance Specifications 31
Setting the Printer Driver

For the functions of other buttons, refer to the Help menu in the
Windows.

Details Tab (Windows 95 / Windows 98)

#
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The ICC Profile name of the KX-P8415 printer is kpsrgb.icm. To use ICM, it must be
displayed in the [Profiles currently associated with this printer:] box as shown in the window
above. If it is not displayed, perform the following steps in the “Color Management” tab.

1. Click  Add...  .

The “Add Profile Association” window is displayed.

2. Select “Windows\System\Color” or “Windows\System” directory, then select

“kpsrgb”.

3. Click  Add  .

4. Click  OK  .

Color Management Tab (Windows 98)

Setting the Printer Driver
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# Shared As
It enables you to share the printer over the network. 
For the detailed information, refer to the Help menu in the Windows.

Sharing Tab (Windows 95 / Windows 98)

#

Setting the Printer Driver
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#

$

%

&

'

)

(

Paper Tab

# Paper Size
Selects a different paper size.
Letter, A4, Legal or Env #10 (Envelope #10) can be selected.

$ Layout
Specifies how many pages of your document to print on one piece of paper. The page
border will be printed by clicking on the Print page border check box.

* +



Settings and Printing Maintenance Specifications 35
Setting the Printer Driver

% Orientation
Selects Portrait (vertical) or Landscape (horizontal).

Portrait Landscape

& Output order
Specifies whether the document prints face up or face down in the output tray. This
selection is not effective, and Face up is automatically selected in the following cases. 
– when Printing on both sides (duplex printing) in the Setup tab (see page 40) is

effective.
– when Multi-Purpose Tray is selected in the Paper source (see below).
– when Transparency is selected in the Media Type (see page 36).

' Paper source
Selects media tray, multi-purpose tray or optional 2nd cassette feeder.
BAutoSelect Tray:

Prints on media loaded in a media tray. The printer picks media from the tray loaded
with the media that is selected in the Paper Size and Media Type. When the tray is
empty, the printer automatically picks media from another tray in the order of Upper,
Middle and Lower.

BMulti-Purpose Tray:
Prints on paper, transparency or label , etc. loaded in the multi-purpose tray.
This selection is not displayed when Printing on both sides (duplex printing) in the Setup
tab (see page 40) is effective.

BUpperS :
Prints on media loaded in the standard tray of the printer.
This selection is not displayed when the auto duplex printing unit has been installed.

BMiddleS :
Prints on media loaded in the upper tray of the optional 2nd cassette feeder.

BLowerS :
Prints on media loaded in the lower tray of the optional 2nd cassette feeder.
The printer will print on the selected media with optimal quality.

S If the optional 2nd cassette feeder has not been installed, these selections are not
displayed.

NOTE
BWhatever you set the Paper Source to under Printer Properties, this will be overruled by the

Setting in the application, under File - Page Setup - Paper Source. For example if you use
Microsoft Word*1 and set the paper source to “Upper” - this will override the Multi-Purpose
Tray's paper source setting under Printer Properties.

*1 Microsoft® Word word processor (hereafter Microsoft Word)

A A
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( Copies
Determines how many copies of the document will be printed.

NOTE
BThe number of copies can also be determined using some application software.

However, it is recommended to set the number of copies using one method, either from
this driver or from an application software to avoid having a printing problem.

) Media Type
Selects the type of media loaded in the media tray or multi-purpose tray. Label, Coated
Paper, Envelope, Card and Paper 2nd Side are available only when the Multi-Purpose
Tray is selected in the Paper source.

Transparency is not available for duplex printing, face down printing and 3 color (CMY)
printing.

* About... button
Displays the window which contains the program version and copyright information.

+ Restore Defaults button
Resets the Paper tab’s settings to the default settings.

Setting the Printer Driver
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Quality Tab

Setting the Printer Driver

#

$
%

&

'

# Self-optimized Adjustment (default setting)
Prints a document in the default setting. Select this mode because usually it is not
needed to change the color setting.

$ User-optimized Adjustment
If you want to adjust the color, click on this button.

% Print Mode
Select a mode to print the document either in color or gray scale (monochrome).
Clicking on Color enables you to use color management feature. Clicking on Gray Scale
enables you to adjust the density of gray scale.

)

*

(
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& Color
This feature provides two-color adjustment functions as described below.

■ Use Agfa CMM
Adjusts the brightness, contrast, saturation, or red, green, blue strength of the image.
For the adjustment, refer to “Using the Agfa CMM” (see page 59).

To have the best color assigned accurately by using Agfa CMM, click on this button,
then click the Rendering Intent.... Select your desired selection (see below) in the
Rendering Intent window. It determines how the printer assigns the color. 

■ Use image color matching (ICM) *1

The printer assigns the best color possible to represent the original color accurately by
selecting different rendering intents. Click on this button, then click the Rendering
Intent.... The Rendering Intent window appears. Select the desired rendering intent,
which determines how the printer assigns the color.

BSaturation: matching is best for graphs and pie charts, in which 
vividness is more important than actual color.

BPerceptual: matching is best for photographic images.
BRelative Colorimetric: matching is best for logo images, in which a few colors 

must be matched exactly.
BAbsolute Colorimetric: matching is used for mapping to a device-independent 

color space.
*1This option is available only when an application software has ICM feature and working

on Windows 95, Windows 98 and Windows 2000.

' Gray Scale 
Adjusts the brightness of the gray scale image.

( Resolution 
Selects a resolution. Standard (600 dpi) or Premium (1200 dpi) can be selected. A higher
resolution provides better print quality. However, the throughput speed is diminished.

Setting the Printer Driver
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) Color mode
■ Use 4 color (CMYK)

Four colors (Cyan, Magenta, Yellow and Black) will be used to print the document.
BHigh Black: ON

Prints the black portion of color graphics using only black toner. Black becomes pure
black. 
This setting is effective only when printing a line art graphic and has no effect for
photo images.

BHigh Black: OFF
Prints the black portion of color graphics using C (CYAN), M (MAGENTA), 
Y (YELLOW) toners. 

■ Use 3 color (CMY)
Three colors (Cyan, Magenta and Yellow) will be used to print the document. 
This selection is useful to print drafts because it can print faster than when using four
colors (Cyan, Magenta Yellow and Black).

* Screening
Selects Smooth or Detail setting. Smooth is suitable for graphics and photographs
because this setting provides smooth graduation. Detail is suitable for detail-oriented
photographs because this setting provides high resolution.
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# Printing on both sides (duplex printing)
Select either Flip on long edge or Flip on short edge when you want to print on both
sides. Before using this feature, make sure that optional auto duplex printing unit has
been installed and the Duplex Unit has been added to the Installed Options box in the
Option tab (see page 42).

Setup Tab

#

$

%

&

)

'

*

(
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$ Overlay 
Overlay feature enables you to overlay an image over a document. See “Overlay Printing”
on page 64 .

■ Print As Overlay
It enables you to save a graphic file as a GDI file that you wish to overlay on a document.

■ Print With Overlay
It enables you to select a GDI file that you wish to overlay on a document when it is
printed. The following are examples to use overlay feature:

BTo incorporate your letterhead on the first page of a business letter 
(Overlay 1st page).

BTo overlay the word “Confidential” on every page of an important document
(Overlay All Pages). 

NOTE
BWhen a document is printed overlaying a graphic, the resolution (Standard or Premium) in

the Quality tab must be the same with one of the graphic file.

% Scaling
It enables you to reduce or enlarge a document to be printed between from 25% and
400%.

& Page Protection
Additionally reserves memory to process the entire page (in memory) composed with very
dense or complex graphics and text before printing out the page.
When overrun error has occurred, check on this check box to print completely .

' Collation
Clicking on this check box prints the copies of the entire document a number of times,
from 1st page to the last page. If you print 3 copies of a 5 pages document, printer prints
page 1 through page 5 three times.

Clicking off this check box prints the copies of the 1st page, then the copies of the next
page and so on.

( About button
Displays the window that contains the program version and copyright information.

) Restore Defaults button
Resets the Setup tab’s settings to the default settings.

* Print as a mirror image
Clicking on this check box allows you to print a mirror image of the document.

Setting the Printer Driver
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Option Tab

#

$

# Available Options / Installed Options
This tab defines whether an option is installed or not. The printer driver installed on the
computer cannot automatically detect that an option has been installed in the printer.
After installing an option in the printer, you must define it using this tab.
It is recommended to change the Option's setting by using the Panasonic KX-P8415
Properties window under Windows to retain the setting ( see page 28).

To define an installed option, click that option in the Available Options box and then
click Add button. The option is moved from Available Options box to the Installed
Options box. If an option in the Installed Options box is needed to be removed, click it
and then click the Remove button.

$ About button
Displays the window that contains the program version and copyright information.
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Displaying the Panasonic KX-P8415 printer Properties Window

(Windows NT 4.0 / Windows 2000)

1 Click Start  , select Settings, then click Printers.
The Printers window is displayed.

2 Click the Panasonic KX-P8415 printer icon.

3 Click the File menu, then click Properties.
The Panasonic KX-P8415 printer Properties window is displayed.

BTabs are different in Windows 2000.

4 Click a tab to view the features.
BPrinter's Printing Preferences window appears by clicking   Printing Preferences... in

Windows 2000.

Ports Tab (see page 44)
Sharing Tab (see page 45)
Color Management Tab (see page 48) [For Windows 2000]

For the features of the other tabs, refer to the Help menu in the Windows NT 4.0 / 
Windows 2000.

Setting the Printer Driver

(tab in Windows NT 4.0)
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Ports Tab (Windows NT 4.0 / Windows 2000)

#

$

# Checked port
Documents will be printed to the checked port.

$ Add Port... button
Adds a new port.

NOTE
BThis option is available only for Windows NT 4.0 / Windows 2000.

(tab in Windows NT 4.0)
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Sharing Tab (Windows NT 4.0 / Windows 2000)

#

$

NOTE
BThis option is available only for Windows NT 4.0 / Windows 2000.

# Shared
It enables you to share the printer over the network. 
For the setup operation, refer to Sharing the printer with a client computer
(see page 46).

$ Alternate Drivers (Windows NT 4.0) / Additional Drivers... (Windows 2000)
It enables you to install an alternate driver.
For the installation, refer to Installing an alternate driver (see page 46).

(tab in Windows NT 4.0)



■ Sharing the printer with a client computer:

1 Click Shared.

2 Type the printer name (for example: KX-P8415).

NOTE
BIf the shared printer is used through Windows 95 or Windows 98, the printer name must not

exceed 12 characters.

3 Click  OK  .

■ Installing an alternate driver (for example: Windows 95 in Windows
NT 4.0):

To install the additional drivers in Windows 2000, click  Additional Drivers... .

1 Select Windows 95, then click  OK  .
The Insert Disk window is displayed.
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2 Click  OK  .
The Printer Drivers for Windows 95 window is displayed.

3 Click  Browse...  .

4 Click  Cancel  .
The Locate File window is displayed.

5 Insert the supplied KX-P8415 CD-ROM into the CD-ROM drive.

6 Select CD-ROM drive.

7 Open Win9x, then select Kx-p8415 file. Click  Open  .
The Printer Drivers for Window 95 window is displayed.

8 Click  OK  .
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The ICC Profile name of the KX-P8415 printer is kpsrgb.icm. To use ICM, it must be
displayed in the [Color Profiles currently associated with this printer:] box as shown in the
window above. If it is not displayed, perform the following steps in the “Color Management”
tab.

1. Click  Add...  .

The “Add Profile Association” window is displayed.

2. Select “WINNT\system32\spool\drivers\color” directory, then select

“KPSRGB”.

3. Click  Add...  .

4. Click  OK  .

Setting the Printer Driver

Color Management Tab (Windows 2000)
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To print on transparency, you can use either the optional transparency tray or the multi-purpose tray.

Using any other tray except the transparency tray may result in media jams.

When using the Multi-purpose tray, see “Printing on Transparency, Label or Envelope (using Multi-

purpose tray)” on page 52.

Available transparency: 3M CG3710

1 Push down on the metal plate until it clicks, locking it in place.
To use a transparency tray, always check the label indication on the tray.

2 Fan the transparencies, then tap them on a level surface to avoid media jams
or skewed printing.

NOTES
BBe careful not to leave fingerprints on the media, which can result in a smudged print.
BReusing media that has been fed through the printer once (for example, after jams) can

reduce the life of the consumables and paper path components.

Printing on Transparency (using Optional Transparency Tray)

Printing on Transparency

Transparency
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3 Place the transparencies (3M CG3710) with the print side down under the
hooks in the tray.
BWhen using 3M CG3710, load them with the leading tape side facing up.

BThe height of media should not exceed the limit mark on the tray, or it may cause a jam.

NOTE

BDo not mix different types of transparencies in the transparency tray at one time; this may
cause a jam.

4 Slide the transparency tray completely into the slot.

5 Display the print window in the application software.

6 Select Panasonic KX-P8415 printer and click Properties .
The Panasonic KX-P8415 Properties window is displayed.

BThe operation for displaying the Panasonic KX-P8415 Properties window may be different
depending on the application software.

7 Click the Paper tab.

Printing on Transparency
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8 Select paper size (#), paper source ($) and media type (%).
#Paper Size: select the size matched with the transparency tray

$Paper source: select AutoSelect Tray

%Media Type: select Transparency

9 Click  OK and print the document.

Printing on Transparency

#

$

%
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1 Set the media thickness switch. 
# Open the left side door (#).

The green media thickness switch is located on the paper feeder.

$ Set the media thickness switch depending on media as follows:
Transparency, Label : set to Middle
Envelope: set to Thick

2 # Open the multi-purpose tray.
$ Extend the media support.

3 Separate the media guides to the approximate width of the media.

Printing on Transparency, Label or Envelope (using

Multi-purpose Tray)

Printing on Transparency, Label or Envelope 

Thin
Middle

Thick
#

$

#
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4 Fan the media, and then tap it on a level surface to avoid media jams or
skewed printing.

NOTE
BReusing media that has been fed through the printer once (for example, after jams)

can reduce the life of the consumables and paper path components.

5 Insert the media with the printing side up into the multi-purpose tray.

The height of media should not exceed the limit mark on the left guide, or it may cause
a media jam.

Printing on Transparency, Label or Envelope 

Taped side facing down
(3M  CG3710)

Label

TransparencyMedia thickness switch position

Continued
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6 Adjust the media guides to the media size.

7 Display the print window in the application software.

8 Select Panasonic KX-P8415 printer and click Properties.
The Panasonic KX-P8415 Properties window is displayed.

BThe operation for displaying the Panasonic KX-P8415 Properties window may be different
depending on the application software.

9 Click the Paper tab.

Envelope

Short-end

Printing on Transparency, Label or Envelope 

Media thickness switch position

NOTES

BPlace only one envelope in the multi-purpose tray at a time. 

BWhen a wrinkle occurs, try printing with the flap inserted inside the
envelope as shown in figure.
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10 Select paper size (#), paper source ($) and media type (%).

# Paper Size: select the media size

$ Paper source: select Multi-Purpose Tray

% Media Type: select the loaded media (Transparency, Label or Envelope)

11 Click  OK and print the document.

Printing on Transparency, Label or Envelope 

#

$ %
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All colors can be defined in terms of three concepts: hue, saturation, and brightness.

Hue
The qualitative aspect of color we generally perceive, such as “red” or “blue”.

Saturation
The vividness of the color.

Brightness
The brightness of the color. A higher brightness provides a lighter image and a lower brightness
provides a darker image.

The following illustration provides a graphical representation of these three concepts. Moving along
the circumference and radius shows the change in hue and saturation respectively and the height
shows the brightness of the color.

Schema for Color Printing

Schema for Color Printing

The Concept of “color”

Brightness

Saturation

Hue
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There are two methods of creating a range of colors. Those are called “additive color system” and
“subtractive color system”.

Additive color system (This system is used by computer monitors.)
This system creates a range of colors by combining varying amounts of Red, Green, and Blue (RGB)
light, which is generally used in the color monitor. Adding the maximum amount of red, green, and
blue light available creates white, on the contrary, black occurs where all these three colors are
absent. Other colors can be created by combining varying amounts of these additive primaries (RGB).

Methods for Creating Colors

Schema for Color Printing
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Subtractive color system (This system is used by color printers.)
This system produces color by combining colorants such as inks, toners or paint on media, which is
generally used in color printing. The printers create the colors by combining the subtractive primaries:
Cyan, Magenta, and Yellow. White occurs where no colorant is applied, on the contrary, combining all
these three color in theory yields black. However, to produce more solid black, black colorant is
added, and consequently color printing uses four process colors: Cyan, Magenta, Yellow, and blacK
(CMYK).

Schema for Color Printing

Color capabilities of the color reproduction devices
Color monitors use the additive color system (RGB), and color printers use the subtractive color
system (CMYK) to create a range of colors. Because these color reproduction devices use different
color systems, some colors that can be displayed on a color monitor cannot be reproduced exactly by
the print device. However, using the Image Color Matching (ICM) system enables more accurate
representation of the original color by assigning the best color possible.
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1 Click on the User-optimized Adjustment button, then click on the
Color button in the Quality tab (see page 37).

2 Click on the Use Agfa CMM button, then click Adjustment...  .
The Adjustment window is displayed.

Displaying the Adjustment Window

Using the Agfa CMM

You can adjust the color of your output using the Agfa CMM (Color Management Module).

#

$

%

&

'

(

) * + ,
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# Brightness
Changes the brightness of an image. A higher brightness setting (increasing %) provides
a lighter image and a lower brightness setting (decreasing %) provides a darker image.

$ Contrast
Adjusts the range between the darkest and the lightest shades in the image.

% Saturation
Changes the brightness and vividness of color. Lower saturation settings (decreasing %)
provide dull and dark images, and higher saturation settings (increasing %) provide bright
and vivid images.

& Red Strength
Lightens or darkens red. A darker level (decreasing %) setting provides a stronger cyan.

' Green Strength
Lightens or darkens green. A darker level (decreasing %) setting provides a stronger
magenta.

( Blue Strength
Lightens or darkens blue. A darker level (decreasing %) setting provides a stronger
yellow.

The range of each option (# to () is from -50% to 50%.

) OK button
Makes a selection effective and closes the window.

* Cancel button
Cancels a selection and closes the window.

+ About button
Displays the window that contains the program version and copyright information.

, Restore Default button
Resets the current setting(s) made in this window to the default setting(s).
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- Profile
Allows you to select, save or delete a color adjustment setting.

■ Save
Saves a color adjustment setting.

■ Save as...
Saves a new color adjustment setting under a new name.

To save a setting:

1. Adjust the color and click Save as button.
2. Enter a new setting name and click OK.

■ Delete
Deletes an existing color adjustment setting.

To delete a setting:

1. Click the right mark        to display the pull down list.
2. Click the setting to be deleted.
3. Click the Delete button, then click OK.

Adjust the color by performing the following steps.

1 Drag each slider left or right or click I or H.

BYou can see the result of the adjustment in the Preview box.

2 Click  OK to make the setting(s) effective.

G



You can adjust the grayscale density of your output using the Brightness window.

1 Click on the User-optimized Adjustment button, then click on the 
Gray Scale button in the Quality tab (see page 37).

2 Click on the Use brightness adjustment check box, then 
Click Brightness...  .
The Brightness window is displayed.
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Using the Brightness Adjustment

Displaying the Adjustment Window

# $ %

Preview box
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# OK button
Makes the adjustment effective and closes the window.

$ Cancel button
Cancels the adjustment and closes the window.

% Restore Default  button
Restores the default image.

Adjust the gray scale by performing the following steps.

1 Drag the slider left or right, or click I or H.

B You can see the result of the adjustment in the Preview box.

2 Click OK  to make the adjustment effective.

LighterDarker
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Overlay Printing

1. Create a graphic file and
store as a GDI file.

Graphic file Overlay All PagesOverlay 1st Page

2. Select overlay option. The
printer provides the
overlaid pages of your
document.

3. Print a document on which
you want to overlay a
graphic file.

Main Steps for Overlaying

1 Using an application such as Paintbrush or CorelDRAW, create and save the
graphic file that you want to overlay on a document.

2 Verify the graphic by printing it.

3 Display the print window and click Properties to display the Panasonic 
KX-P8415 Properties window.

ABC Company

or

3
2

1

ABC Company

ABC Company

3

ABC Company

2

ABC Company

1
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4 Click on the check box of Print As Overlay in the Setup tab. 

5 Enter a new file name or the same file name with GDI extension 
(ex. OVERLAY.GDI) in your desired directory as used in step 1 in the File
Name box.
You can select the desired directory by clicking   Browse   .
If you are working under Windows NT 4.0, the directory in which you want to save the file 
can not be changed.

6 Click  OK .

7 Print the graphic to the KX-P8415 printer.
Actually you will be printing to a file, so no print-out will come from the printer. Your created 
file will be stored as a GDI file.

check box of Print As
Overlay
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8 Minimize or close this application.

9 Open a document to print with the graphic and display the print window.

10 Click Properties to display the Panasonic KX-P8415 Properties window.

11 Click on the check box of Print With Overlay in the Setup tab.

check box of Print With
Overlay

12 Click on the Overlay 1st Page or Overlay All Pages button.

Overlay 1st Page:  The graphic is overlaid only on the first page of a document.

Overlay All Pages: The graphic is overlaid on all the pages of a document.
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13 Click Browse and select the directory in which you saved your graphic file
(GDI file), then select the graphic. Click  OK .

The selected file will appear in the File Name box.

14 Click  OK .

15 Print the desired document with the graphic overlaid.
BThe resolution (Standard or Premium) in the Quality tab must be the same with one of the

GDI file stored at step7.

Overlay Printing



Settings and Printing Maintenance Specifications 68
Duplex Printing

Duplex Printing

If you manually perform the duplex printing, first odd pages are printed and then even pages 
(see page 70).
By installing the optional 2nd cassette feeder with ADU (Auto duplex printing unit) in your printer, it
can automatically perform the duplex printing. See “Specifications” for the notes when performing
automatic duplex printing.

Auto duplex printing unit should be used only for automatic duplex printing. Do not load any media in
this unit, otherwise jam will occur.

Specified media for duplex printing: Laser paper 75-90 g/m2 (20-24 lbs.)

1 Make sure the Auto duplex printing unit is installed in the Upper tray slot.

2 Load paper [laser paper 75-90 g/m2 (20-24 lbs.] into the Middle or Lower tray 
(upper or lower tray of the 2nd cassette feeder).

BAutomatic duplex printing cannot be performed by feeding paper from the multi-purpose
tray.

3 Display the print window in your application.

4 Select Panasonic KX-P8415 printer and click Properties.
The Panasonic KX-P8415 Properties window is displayed.

BThe operation for displaying the Panasonic KX-P8415 Properties window may be different
depending on the application software.

Automatic Duplex Printing (with Auto duplex printing unit)
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Duplex Printing

5 Click the Setup tab in the Printer Properties window and select either Flip on
long edge or Flip on short edge.

6 Click  OK , then print.
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Single sided documents can be printed on both sides of the paper using an application software, such
as Microsoft® Word for Windows 95. The instructions described here are only for Microsoft Word for
Windows 95. See “Specifications” for the notes when performing manual duplex printing.

NOTE when making a few copies of the document that the last page is odd page using
the collation feature:

BWhen printing the even pages of the document after printing the odd pages, the last page
of the next copy will be printed on the back side of the last page. To avoid this,
- Print the document one by one. (Do not use the collation feature).
- Remove the last page of the copies after the odd pages are printed, then print the even

pages.

Specified media for duplex printing: Laser paper 75-165 g/m2 (20-44 lbs.)

1 Set the media thickness switch to Middle or Thick depending on the paper
used (see “Using the Multi-purpose Tray”).

2 Load paper [75-165 g/m2 (20-44 lbs.)] in the multi-purpose tray.

3 Open a document in Microsoft Word for Windows 95.

4 From the File menu, click Print... .

The Print window is displayed.

5 Make sure that Panasonic KX-P8415 is selected in the Printer box, then click
Properties .

The Panasonic KX-P8415 Properties window is displayed.

Duplex Printing

Manual Duplex Printing (Using Microsoft Word for Windows 95)
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6 Select Multi-purpose Tray from the Paper source, then select Plain Paper
from the Media Type pull down menu in the Paper tab. Click  OK .

The Panasonic KX-P8415 window is closed.

NOTE
BWhatever you set the Paper Source to under Printer Properties, this will be overruled by the

Setting in the application, under File - Page Setup - Paper Source. For example if you use
Microsoft Word and set the paper source to “Upper” - this will override the Multi-Purpose
Tray's paper source setting under Printer Properties.

7 Select Odd Pages from the Print menu box, then click  OK . 
The Print window is closed and odd pages will be printed face up.

8 Place the printed pages in the multi-purpose tray with the pages face down
and top first.

Duplex Printing

Print menu box
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9 From the File menu, click Print... .
The Print window is displayed.

10 Click  Properties .
The Panasonic KX-P8415 Properties window is displayed.

11 Select Multi-Purpose Tray from the Paper source pull down menu, then select
Paper 2nd Side from the Media Type pull down menu in the Paper tab.
Click  OK .
The Panasonic KX-P8415 Properties window is closed.

12 Select Even Pages from the Print menu box, then click  OK  .
The Print window is closed and even pages will be printed on the back side of the paper.

Duplex Printing
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